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Aipotu IV: Evolution 
 
Objectives: 

• To explore evolution with evolving digital organisms. 
• To complete the study of the Aipotian flowers you started in Bio 111 
• To test evolutionary hypotheses. 
• To try out different evolutionary scenarios. 
• To address several misconceptions about evolution. 

 
Introduction: 
 Life only evolved once on earth.  In addition, for most organisms, evolution happens 
very slowly on a human time scale.  As a result, it is difficult to explore evolution 
experimentally – to address questions like “What would have happened if …?” or “Did it 
necessarily have to happen this way?” 
 To explore evolution in detail, you need organisms with a complex genotype that can 
reproduce rapidly. In this lab, you will explore the evolution of simple digital organisms as 
they evolve in the computer simulation, Aipotu. 
 Aipotu simulates the production of color in a hypothetical species of simple diploid 
flowers.  In Bio 111, you looked at the genetics, biochemistry, and molecular biology of flower 
color in these simulated flowers.  In this lab, you will look at the evolution of color in these 
flowers.  In Aipotu, color results from the particular color protein genes an individual 
possesses.  Since these genes are subject to mutation – as you saw in the Aipotu III lab – and 
we can model differential fitness based on color, Aipotu can simulate the evolution of colors in 
these flowers.   Since the flowers in Aipotu are subject to random mutation and non-random 
selection, they evolve like organisms in the real world. 
 As a reminder, color is controlled as follows in the Aipotian flowers: 
• Molecular Biology: Each organism carries two copies of a gene that can produce a pigment 

protein.  Each of these genes is a DNA sequence.  The simulation attempts to express each 
gene by looking for the appropriate signal sequences (promoters, terminators, splice sites, 
start codons, and stop codons - just like real genes) in the DNA sequence and producing 
any protein encoded therein.   
 Mutations alter the DNA sequence randomly by changing bases, deleting bases, or 
inserting bases.  These mutations can lead to the production of altered proteins. 

• Biochemistry: Proteins encoded by the DNA sequence are folded in 2-dimensions using 
the usual rules of protein structure: hydrophobic side chains cluster out of the water; 
hydrophilic side chains are in contact with the surrounding water; side chains can form 
hydrogen bonds or ionic bonds if they have the appropriate structure and location in the 
chain.   
 Proteins with a particular shape – a hexagonal hydrophobic core of seven amino acids 
with six hydrophilic amino acids nearby – can be colored; proteins without this shape are 
white (colorless).  The particular color depends on the content of the hydrophobic core: if 
the core contains phenylalanine, the protein is red; if it contains tryptophan, it is yellow; if 
it contains tyrosine, it is blue.  These colors combine as paint pigments do: red + yellow = 
orange; red + blue = purple; blue + yellow = green; red + blue + yellow = black.   

• Genetics: The flower color genes are inherited as any other genes are in a diploid 
organism.  Each individual has two copies of the gene for flower color and passes one of 
them to each of its offspring.  The final color of a flower depends on the genes present.  
White is recessive to all other colors while the other colors combine as above.  That is: a 
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heterozygote with one red allele and one yellow allele would be orange.  A heterozygote 
with one orange allele and one green allele would be black since it contains all three colors: 
red from the orange allele; blue from the green allele; and yellow from both alleles. 
Furthermore, a heterozygote with one orange allele and one red allele is orange (not red-
orange). 

 
 It is important to note that this is not the way colors work in nature.  In nature, proteins 
fold in 3 dimensions and flower colors are typically due to small molecules synthesized by 
several enzymes.  Although the Aipotu simulation is unrealistic in these key details, it still 
retains many of the features necessary for understanding evolution, as you will see. 

 
If you have questions about these, you should consult the Bio 111 On-Line Lab Manual for 
more details on Aipotu. 
 
In this lab, we will use the last part of the Aipotu simulation: 
 
• Evolution: To simulate evolution, you need to have a large population of Aipotian flowers.  

We will use a population size of 100 – this is small by real-world standards, but large 
enough for our purposes without being so large that the program runs too slowly. 
 In Aipotu, the flowers are annuals – they live for only one year and die after producing 
seeds for the next generation.  Each year is one generation where the seeds from last year 
grow and produce flowers.  These flowers are subject to natural selection based on their 
colors.   
 Each generation, flowers grow from last year’s seeds.  The flowers contribute to the 
‘gene pool’ for the next generation based on their fitness: those with colors that have high 
fitness contribute more copies of their color genes to the gene pool than those with colors 
that have low fitness; flowers with colors with zero fitness do not contribute any of their 
alleles to the gene pool.  All the parents then die.  Each individual in the next generation is 
produced by drawing two alleles randomly from the gene pool; these alleles are then 
subject to random mutation.  The next generation grows from these individuals and 
replaces their parents with exactly 100 individuals. 
 The simulation does not model how the natural selection based on color occurs.  It could 
be due to predators’ or pollinators’ color preferences, or something altogether different.  In 
the simulation, all that matters is that fitness depends on color and color depends on genes.  
We thus have all the requirements for evolution: variation in color; that variation is genetic; 
and fitness depends on color.  Thus, alleles of the color gene that contribute positively to 
fitness will increase in frequency, while those that contribute negatively will decrease in 
frequency.  All the time, mutations will be busily creating new alleles. 
 You can change all of the relevant parameters: starting population, mutation rates, and 
relative fitness.  This gives you a ‘laboratory of evolution’ where you can watch evolution 
happening and see what would happen if … 
 

We will begin by looking at some population genetics scenarios with mutations turned off for 
simplicity.  We will then turn mutations on to explore more complex evolutionary scenarios. 
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Part A: Population Genetics 
 In this part of the lab, we will use Aipotu to simulate Hardy-Weinberg Population 
Genetics.  We will begin by looking at Natural Selection in the absence of mutation. 
 In this part of the lab, we will only look at red and white colored flowers.  In this case, 
flower color is controlled by one gene with only two alleles: 
 
 Allele Contribution to Phenotype    Genotype Phenotype 
     R red (dominant)            RR   red 
     r white (recessive)            Rr    red 
                 rr    white 
 
1) Start Aipotu by clicking on its icon in the Dock.  You should see something like this: 
 

 
 
The Genetics, Biochemistry, and Molecular Biology Work Areas are the same as you saw in 
Bio 111. If you need a reminder of how to use the Genetics, Biochemistry, or Molecular 
Biology parts of Aipotu, there are links to the relevant lab manual sections on the OLLM for 
this lab. 
 
If you don’t see this or see other flowers in the Greenhouse besides those shown above, restart 
the computer to get a fresh copy of the program. 
 
 

These buttons select which 
part of the program – 
which Work Area – you 
are using. 

This is the Greenhouse; you 
get your starting flowers here 
and can save important 
flowers here for further study. 

This is the Status Bar; it tells 
you what the program is doing. 
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2) Click on the “Evolution” button at the top to go to the Evolution Work Area; you should see 
this: 

 
 
3) You must first turn off mutation for this part of the lab.  From the File menu, choose 
Preferences…; you will see this: 

 
 

Click on Mutation Rates, and you should see this: 

 
 

Uncheck the Mutations Enabled checkbox (the mutation rate numbers should gray out), and 
click OK.  Mutations are now off. 
 

This is the World; the 
flowers live here. 
Each square shows 
the color of the flower 
living there. These are the Settings; you 

set the fitness of each color 
here and the software shows 
how many of each color are 
present in the World. 

These are the Controls; you stop 
and start the simulation here. 
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Now, you will run some simulations of Natural Selection. First, to get a qualitative feel for 
what happens, and then more quantitatively.  Note that, since mutations are off, no new alleles 
will be produced, so no new colors will appear. If they do, you haven’t turned off mutations… 
 
A) Select for Red. 
 
A1) Click on the Red organism in the Greenhouse to select it; its border will turn green.  While 
holding the shift key, click on the White organism in the Greenhouse; now, both should be 
selected. 
 
A2) Click the Load button in the Controls. The World will fill with a roughly 50:50 mix of red 
and white organisms.  Note the count of red and white in the Settings panel; it should be 
about 50 of each. 
 
A3) Set the Fitness settings in the Settings panel to select for red.  Set the fitness of red to 10 
(the maximum) and all the other colors to 0 (the minimum). 
 
A4) Prediction: What should happen to the number of red and the number of white flowers 
after several generations with this selection? 
 
 
 
 
 
 
A5) Test: Click the One Generation Only button in the Controls. This will run one generation 
only. First, the starting flowers will contribute to the gene pool based on their fitnesses.  Then 
the starting flowers will die off and be replaced by exactly 100 offspring.  Each offspring 
flower will get two alleles randomly chosen from the gene pool. 
 
A6) Result: What happens to the counts of red and white flowers as you simulate more 
generations?  Roughly how many generations does it take to get to pure red? Be careful, as 
some all red generations can have some white offspring (why?). 
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B) Select for White. 
 
B1) Click on the Red organism in the Greenhouse to select it; its border will turn green.  While 
holding the shift key, click on the White organism in the Greenhouse; now, both should be 
selected. 
 
B2) Click the Load button in the Controls. The World will fill with a roughly 50:50 mix of red 
and white organisms.  Note the count of red and white in the Settings panel; it should be 
about 50 of each. 
 
B3) Set the Fitness settings in the Settings panel to select for white.  Set the fitness of white to 
10 (the maximum) and all the other colors to 0 (the minimum). 
 
B4) Prediction: What should happen to the number of red and the number of white flowers 
after several generations with this selection? 
 
 
 
 
 
 
B5) Test: Click the One Generation Only button in the Controls. This will run one generation 
only. First, the starting flowers will contribute to the gene pool based on their fitnesses.  Then 
the starting flowers will die off and be replaced by exactly 100 offspring.  Each offspring 
flower will get two alleles randomly chosen from the gene pool. 
 
B6) Result: What happens to the counts of red and white flowers as you simulate more 
generations?  Roughly how many generations does it take to get to pure white? 
 
 
 
 
 
 Why does it take more generations to get to pure red than it does to get to pure white?   
  Hint, you can see the genotype of each flower by checking the Show colors of  
  both alleles in the World Settings part of the Preferences… . 
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Now, we will get quantitative. 
 
C) Hardy-Weinberg Equilibrium & Natural Selection 
 
C1) Load the World with only the Red organism from the Greenhouse.  The World should be 
entirely red. 
 
C2) Show the colors of both alleles in each organism by checking the Show colors of both 
alleles in the World Settings part of the Preferences… if you haven’t already. You should see 
little red and white rectangles in the upper left corner of each organism in the World – this 
indicates that each has one red and one white allele = genotype Rr. 
 
C3) Set all Fitnesses to 5. 
 
• Is this population at Hardy-Weinberg Equilibrium? 
 
C4) Calculate the allele frequencies in the starting population: 
  Genotype Number #R’s  #r’s 
 
      RR     
 
      Rr 
 
      rr  
           
    TOTAL: 
 
  • frequency of R (p) =   
 
  • frequency of r (q) =  
 
C5) Calculate the genotype frequencies expected at HWE: 
 
  • frequency of RR = p2 =  
 
  • frequency of Rr = 2pq = 
 
  • frequency of rr = q2 = 
 
C6) Is the population at HWE?  Why or why not? 
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C7) Run one generation only.  Is that population at HWE?  You may find it useful to pool the 
class results to get an answer that is less subject to small-sample-size fluctuations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
C8) Set the Fitness settings in the Settings panel to select for red.  Set the fitness of red to 10 
(the maximum) and all the other colors to 0 (the minimum). 
 
C9) Prediction: What should happen to p and q after several generations with this selection? 
 
 
 
 
 
 
C10) Test: Click the One Generation Only button in the Controls. Do this a few times. 
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C11) Result: Calculate p and q as you did in part (d): 
 
  Genotype Number #R’s  #r’s 
 
      RR     
 
      Rr 
 
      rr  
           
    TOTAL: 
 
 
  • frequency of R (p) =   
 
  • frequency of r (q) =  
 
C12) Does the result match your prediction? Why or why not? 
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Now, we will turn mutations on and observe the evolution of new alleles and new colors. 
 
4) Choose Preferences… from the File menu and click on the Mutation Rates button. Click 
Enable Mutations and then click OK. Mutations are now enabled. 
 
Note: in nature, mutation rates vary but a rough figure is that any given base in DNA has a 
1/500,000,000 chance of being mutated in a given individual in each generation.  In this 
simulation, the mutation rate is about 3/1000.  Taking into account the population size of 100, 
this is roughly 15,000 times higher than the ‘natural’ rate; therefore, one generation – one 
“year” – in Aipotu is roughly equivalent to 15,000 years in real life.  You should know that this 
is a very approximate calculation! 
 
Part II: Misconceptions about Evolution 
 
 In this section, you will perform a series of experiments that address several common 
misconceptions about evolution.  For each experiment, you will begin by conducting the 
experiment and observing the result.  You will then determine which misconception(s) it 
addresses. Finally, you will make predictions about what the outcome of the experiment 
would have been if the misconception were true.  
 
Misconceptions 

1. Mutations always reduce the fitness of organisms.  Since mutations damage genes, they can 
only impair their function and must therefore reduce the fitness of the organism.  {In 
fact, mutations can be neutral, beneficial, or deleterious} 

2. Selection causes mutations that are adaptive.  For example, the presence of an antibiotic 
causes the mutations that make the bacteria antibiotic resistant. {In fact, the mutations 
are always random and occur before the selection} 

3. All new phenotypes are equally likely to occur by mutation.  For example, if you have 
primitive cats, a mutation that results in high speed is just as likely as a mutation that 
results in great strength or sharp teeth. {In fact, some phenotypes are ‘easier to evolve’ 
than others} 

4. Mutations cannot produce new features.  Since mutations are random and destructive (see 
#1), they cannot create new features. {In fact, that is how all the amazing diversity of life 
originated} 

5. There is only one mutation that can cause a given phenotype.  For example, there is only one 
particular DNA change that could change a slow cat into a faster cat. {In fact, although 
this is true for some phenotypes, in most cases, any given phenotype can be caused by 
several mutations} 

6. Evolution has a goal.  If the world were somehow started over, the result would be the 
same world we see today.  {In fact, chance plays a huge role in evolution and the 
outcome would likely be very different} 

 
 Each of the following experiments will address one or more of the above 
misconceptions.  Also, a given misconception may be addressed by more than one experiment. 
Note that time you click Run in Aipotu, it is like starting evolution all over.  Each run is a new 
earth, started with slightly different conditions and/or different random events. 
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Experiments 
 
IMPORTANT For these experiments, you must turn mutations on!  The easiest way to do this 
is to quit and re-start Aipotu.  That will restore all the default settings. 
 
D) Starting with Green-1; no selection.  
 Here, you will start with Green-1, which is a homozygote – it has two identical green 
alleles.  You will let it reproduce with random mutations, but no selection.  That is, all colors, 
including white, will be equally fit. 
 
D1) Quit and re-start Aipotu to enable mutation. 
 
D2) Go to Evolution and load the World with Green-1 from the Greenhouse.   
 
D3) Click Run and let the simulation run for about 5 generations. 
 
D4) What colors do you see? Specifically:  
 
 - What colors besides green are present in your World?   
  
 
 - What colors are present in the World’s of the other groups in your lab? Based on these  
  class results, which colors occur often and which are rare? 
 
 
 
 - Which misconception(s) does this address?  For each, what would the result have been  
  if the misconception were true? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
D5) Save one of the black flowers to the Greenhouse. To do this: choose one of the black 
flowers from your World, click on it to select it (its border will turn black) and click the Add… 
button at the top of the Greenhouse.  Give it a name when the program asks you and it will 
appear in the Greenhouse.  You can now examine it using the other tools in Aipotu. 
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D6) Switch to Biochemistry and double-click the organism you just saved in the Greenhouse.  
The program will then show you the proteins encoded by the two copies of the pigment 
protein gene in this organism along with their individual and combined color.  A sample is 
shown below; yours will likely look different: 
 

 
 
Note that the proteins have different shapes – that is why they have different colors. 
 
Typically, the black mutants that occur early on are heterozygotes containing one un-mutated 
green allele (the bottom one in the example above; yours may be different) and one mutant red 
allele (the top one in the example above; yours may be different). 
 
Look at the black mutants of your classmates; they should almost all be red/green 
heterozygotes.  All the green proteins should be the same (since they’re likely to be un-
mutated); the red proteins are likely to be different from each other. 
 

This color chip shows that the 
top protein is red on its own. 

This color chip shows that the 
bottom protein is green on its own. 

This color chip shows that the 
combined color of the organism 
is black. 
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To see how the red protein came to be, you will need to look at the DNA sequences in the 
Molecular Biology workarea.   
 
D7) Switch to Molecular Biology.  In order to compare the mutant and starting sequences, you 
will need to save the sequence of the un-mutated green allele for comparison.  To do this, you 
double-click on the Green-1 in the Greenhouse.  You should see the sequences of two identical 
green genes appear as shown below: 

 
 
D8) From the Edit menu, choose Copy Upper Sequence to Clipboard (be sure not to choose 
either of the “image” options).  This copies the upper DNA sequence – the un-mutated green 
allele that all the mutants started from – to the program’s memory. 
 
D9) Double-click on the black mutant organism you saved in the Greenhouse.  You will see its 
two copies of the pigment protein gene in a window like the one above.  One will be green and 
one will be red.  You want to look at the red one – note whether it is the upper or lower 
sequence. 
 



 Aipotu IV-14 

D10) From the Compare menu, choose Compare Upper vs Clipboard (or Lower, whichever is 
the red one) and you will see a display of the differences between the two DNA sequences like 
the one shown below (if no differences are shown, you compared two identical green alleles; if 
you tried Upper, try Lower and vice-versa). Yours will be similar, but not identical, to this. 
 

 
 
Note the * at position 52.  This indicates the single difference between the clipboard sequence 
(the green allele that you  started with) and the red mutant; that is, the mutation that made the 
allele red. In this case, the “-“ in the clipboard sequence indicates that the T in the red mutant 
is not present in the original green allele.  Therefore, the mutation that made the red allele was 
an insertion of a T between bases 51 and 52.  This resulted in a frame-shift mutation that led to 
the production of a red protein.  Your mutation will likely be different. 
 
Make a list of the ‘red mutations’ from your class. Are they all the same?  How is it possible 
that more than one mutation can lead to the same phenotype?  How does this explain why 
some colors are rare and others are not? 
 
 - Which misconception(s) does this address?  For each, what would the result have been  
  if the misconception were true? 
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E) Starting with Green-1; with and without selection for Orange. 
 Here you will pool class results to see how many generations it takes for Orange to 
evolve with and without selection for orange. 
 
• First run; without selection for orange.   
 
E1) Load the World with Green-1 from the Greenhouse. 
 
E2) Set all the fitness values to 5 (default value). 
 
E3) Click Run and watch for the first appearance of an orange flower. Note the generation 
number when it appeared in the space below.  If you get to Generation 10 and still have not 
seen an orange flower, click Pause and write “>10” in the space below. 
 
    Generation #   
 
 - Did it take the same number of generations for all groups? Would you expect it to?   
  Why or why not? 
 
 
 
 
 - Roughly how many generations did it take to get the first orange in the absence of  
  selection for orange? 
 
 
• Second run; with selection for orange. 
 
E4) Load the World with Green-1 from the Greenhouse. 
 
E5) Set the fitness values to select for orange; that is, set orange to 10 and all the others to 2. 
 
E6) Click Run and watch for the first appearance of an orange flower. Note the generation 
number when it appeared.  If you get to Generation 10 and still have not seen an orange 
flower, click Pause and write “>10” in the space below. 
 
    Generation #   
 
 - Did it take the same number of generations for all groups? Would you expect it to?   
  Why or why not? 
 
 
 - Roughly how many generations did it take to get the first orange in the absence of  
  selection for orange? 
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 - Which misconception(s) does this address?  For each, what would the result have been  
  if the misconception were true? 
 
 
 
 
 
 
 
 
 
 
F) Evolution of color from colorless proteins. 
 Here, you will start from a colorless protein of your own devising and see if you can 
evolve colored proteins from that via random mutation and non-random selection. 
 
First, you must build a working gene that encodes a short protein.  Don’t use the white flowers 
from the Greenhouse; the protein in these flowers is only one mutation away from color, so 
using it would be unfairly ‘stacking the deck’. 
 
F1) Switch to Molecular Biology and click on Enter New DNA Sequence in the top 
workpanel.  You will be presented with a dialog box into which you can enter your DNA 
sequence. 
 
Build your gene step by step. 
 
F2) A gene needs a promoter (TATAA in Aipotu) and a terminator (GGGGG) to make an 
mRNA.  If you type something like the sequence shown below and click OK, it will create a 
gene that makes a small mRNA. 
 
  CTATAACCGGGGGC 
 
 promoter   terminator 
  
  the extra C’s are just spacers – they can be any sequence 
 
You should see something like this when you click OK: 

 
 
F3) Now you can type in your coding region directly.  Just hold the shift key while you type 
the DNA sequence (A, G, C, or T) and the bases will be inserted.  Type a start codon (ATG), 
codons for 10-12 amino acids (this is where you get to be creative), and a stop codon (TAA).  

Click on the top DNA strand 
anywhere between the 
promoter (green) and the 
terminator (orange) to get 
this (note the blue highlight): 
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If you’ve got it working, you should see something like this (your protein should be different): 

    
You can edit the DNA sequence to get the protein the way you want it by clicking on bases in 
the top DNA strand.  Once a base is selected, you can change it by typing lower case a, g, c, or 
t; you can delete it by hitting the delete key. 
 
F4) Once you’ve got a working gene, you should fold the protein to be sure it isn’t colored 
(remember that you want to start with a colorless protein for this experiment).  Click the Fold 
Protein button.  An item will appear in the History List showing the shape of the protein and 
the color chip in the Upper Folding Window will show its color.  You can further edit the 
DNA and fold the new protein until you are happy with your starting protein. 
 
F5) Now,  you need to make an organism that is homozygous for your gene.  Double-click on 
the item in the History List that corresponds to the desired protein and choose Send to Lower 
Panel from the menu that pops up.  You should now see two identical genes, one in the Upper 
and one in the Lower Gene Window. 
 
F6) Now, save the organism to the Greenhouse so you can use it for evolution.  Click the 
Add… button over the Greenhouse and give your organism a suitable name.  It will appear in 
the Greenhouse – it should be white. 
 
F7) Switch to Evolution.  Set the fitness values to select for colored proteins.  Set the fitness of 
white to 1 (you want it low to favor colors, but not 0 or you’d kill all your starting population!) 
and all the other colors to 10.   
 Alternatively, if you want to select for a particular color, you can set that fitness higher 
than the others.  However, it will evolve to your color faster if you set the fitness of the other 
colors to something higher than 0. Why? 
 
F8) Load your organism into the World and start it evolving.  Wait and see if you get colored 
flowers.  This may take a while…  If and when you do get a colored organism, save it to the 
Greenhouse and compare the protein and DNA to your starting gene as you did in A8-A10.  If 
you don’t, you can try another protein sequence or just wait a long time…  It is likely that at 
least one of your classmates will be successful. 
 
 - Which misconception(s) does this address?  For each, what would the result have been  
  if the misconception were true? 
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Lab Report 
• Must be typed; hand-drawn graphs are acceptable. 
• Due at the start of lab during the week indicated on the syllabus; this is a firm deadline. 
• Your lab report must be in your own words. 
• Please submit two copies of your report so that we can save a copy to help us improve the  
 lab. 
 
Your lab report must include: 
 
Choose any one of the misconceptions described on page Aipotu IV-10 and answer the 
following questions about that misconception. 
 
1) Which misconception did you choose? 
 
2) Although misconceptions are not correct, they often seem reasonable if you don’t know all 
the details. Explain what might lead someone to think that the misconception you chose was 
plausible. 
 
3) Explain how the data you collected in lab shows that the misconception you chose is 
incorrect. 
 
4) A skeptic could argue, “Aipotu is just a computer simulation. It has nothing to do with real 
organisms. Any conclusions you draw from it are not relevant in the real world.”  How would 
you argue that, although Aipotu is a computer simulation, the results from it are still relevant 
to the misconception you chose?  In other words, “In what relevant ways is Aipotu similar to 
the real world so as to allow one to draw meaningful conclusions about this misconception?” 
 
5) Find an example from evolution in the real world that also demonstrates that this 
misconception is incorrect.  Describe the example and explain how it shows that the 
misconception is incorrect.  Be sure to cite the source of your information.  It is OK to use 
Campbell, the world wide web, or materials from lecture. 
 


